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Title of equipment: UV direct writer 

Model: UVW03 

 

Product Description: 

This product is a device for micro-lithography that uses a UV laser beam to draw patterns. It 

supports both raster scanning by loading image files to be used as masks and vector scanning, 

where the laser follows lines drawn with a mouse. It is utilized in maskless lithography processes 

using positive photoresists (PR) for the fabrication of research-scale semiconductor devices, such as 

chips with dimensions of several centimeters. The device is applicable for manufacturing various 

research devices, including semiconductor devices, solar cells, and water-splitting devices. 

Product Dimensions: 

Width: 28 cm x Depth: 36 cm x Height: 47 cm 

 

Hardware Description: 

(Light Source): The device is built using a 405 nm laser diode. The light intensity is feedback-

controlled based on the photocurrent 

value measured by the built-in 

photodiode. The laser power is designed 

to reach up to 500 µW.  

(Front of the Device): At the front of the 

device, there is a sample stage 

connected to the scanner, with a 

microscope objective lens mounted 

above it. The objective lens can be 

rotated either manually or automatically 

to select magnifications of 5x, 10x, 20x, 

50x, or 100x. Similar to a standard 

optical microscope, users can observe 

the substrate at low magnification and 

gradually move to higher magnifications 

to precisely determine the areas for patterning. 

Figure 1: Mount for Sample Wafer Installation and 

Objective Lenses 
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(Rear of the Device): The back of the device features a power switch and a USB connector. The 

USB connector must be connected to a USB 3.0 port on the control PC (USB 2.0 is insufficient for 

camera operation). 

Sample Substrate Installation: 

This product uses a red LED illuminator to observe the substrate without exposing the photoresist 

to light. For research device fabrication, wafer substrates of 1-2 cm in size are placed in the center 

of the stage. A rectangle is marked on the sample stage, and the sample should be positioned so 

that the area to be patterned lies within this rectangle. 

 

Wafer Size: 

This product allows patterning up to a maximum size of 25 mm and provides a spacious stage 

capable of accommodating substrates larger than 5 cm. A square area is marked on the black stage, 

indicating the region where the laser beam can write. With a z-axis adjustment range exceeding 1 

cm, the device is compatible with wafers of varying thicknesses. For wafers of different thicknesses, 

users can initially set a rough focus at low magnification and gradually shift to higher magnifications 

for precise focusing. 

XY Positioning of the Sample: 

To align the desired area of the sample with the laser focus, first activate the illuminator by pressing 

the "Illuminate On" button in the app's right-hand menu. Once the illuminator is turned on, a red 

light will project onto the sample surface through the objective lens. Position the area to be 

patterned within this red-illuminated spot. 

Sample movement is controlled via the keyboard or app menu. Using the arrow keys on the 

keyboard moves the stage in 100-micrometer increments. For instance, pressing the right arrow key 

shifts the sample to the right, causing the image on the screen to move accordingly. (Refer to the 

app menu for shortcut key locations and customization options.) 
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Right-Side Shortcut Buttons: 

(Camera Capture) Pressing the "Camera Capture" button temporarily 

turns on the illuminator, captures a microscope image, displays it on 

the screen, and then automatically turns off the illuminator. This 

function minimizes exposure to prevent PR damage while observing 

the sample. 

(Wide View): The "Wide View" button allows users to observe a larger 

area. It moves the scanner to collect nine surrounding images and 

stitches them together to display a wide-field image of the substrate. 

(Video On/Off) Pressing the "Video On" button displays real-time 

video from the camera mounted on the microscope in the main 

window. Pressing the "Video Off" button stops the live video feed. 

(Objective Lens): Buttons for selecting objective lenses with 

magnifications of 5x, 10x, 20x, 50x, and 100x are provided. Pressing 

a button automatically switches to the selected lens. The scale bar 

and screen position adjust accordingly to maintain the center of the 

field of view. 

*** Alignment Tip: 

To align a large area down to a central fine region during the 

writing process, start with the 5x objective lens and sequentially 

switch to higher magnifications (10x, 20x, 50x, and 100x). At each 

magnification, center the field of view and capture an image. At 

100x magnification, use zoom-in/out to align the mask image 

with the captured images corresponding to each zoom level. This 

process simplifies the alignment workflow by displaying the 

mask image alongside the captured images on the screen. 

 

(Writing Area): The numbers displayed in the "Writing Area" window 

represent the maximum pattern size. This value can be adjusted by 

accessing the Writing Configuration menu. 

(Laser): In the input field, users can set the laser intensity by entering a value between 0.1 and 5. 

Figure 2: Right-Side Menu 

Panel of the Main Window 
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Pressing the "On" button activates the laser, while pressing the "Off" button deactivates it. 

(Illuminate): The "On" button turns on the red LED light connected to the objective lens, allowing 

the observation of the sample surface. Pressing the "Off" button switches off the illumination. 

(Focus): Pressing the "Focus" button initiates an automatic focusing process. During this process, 

the z-axis motor moves to adjust the focus, which can be monitored through the display.  

 

<Focusing Procedure> 

Focus Adjustment Using "Laser" and "Sample" Buttons: 

Located next to the "Focus" button, the "Laser" and "Sample" buttons help streamline the 

focusing process by allowing users to visually fine-tune focus directly on the screen. 

"Laser" Button: 

Pressing the "Laser" button shifts the z-axis value in the positive direction by the amount 

specified as (laser focus from sample focus) in the Objective Lens menu. 

The laser automatically turns on at an initial intensity of 0.1 V, and the camera exposure time is 

reduced to make the laser beam easier to distinguish. 

Adjust the z-axis value until the laser focus appears smallest (sharpest) on the screen, and note 

this optimal laser focus position, z_laser. 

"Sample" Button: 

Pressing the "Sample" button shifts the z-axis value in the negative direction by the same 

amount (laser focus from sample focus) specified in the Objective Lens menu. 

The laser automatically turns off, and the camera exposure time increases to make the sample 

more visible. 

Adjust the z-axis value until the sample appears clearest, and note this optimal sample focus 

position, z_sample. 

Verification and Calibration: 

Calculate the difference: z_sample - z_laser. 

Verify that this value matches the "laser focus from sample focus" value set for the specific 

objective lens in the Maintenance -> Objective Lens menu. 

If there is a discrepancy, update the setting in the menu to reflect the correct value. 

Automatic Integration in Writing Process: 

Once the "laser focus from sample focus" value is set, it will be automatically applied during the 

writing process to ensure optimal focusing without manual adjustments. 
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Features and Operations 

Position Display and Adjustment: 

• The "Position (um)" window displays the current motor positions for X, Y, and Z axes in 

micrometers. 

• Enter a value in the input field and press Enter to move the motor to the specified position. 

• When moving along the Z-axis, ensure there is enough clearance between the objective 

lens and the sample. 

• Z-Axis Adjustment Buttons: 

o The "+" and "–" buttons next to the Z position field allow movement in 1 µm 

increments. 

o Using the keyboard arrow keys moves the stage in 100 µm increments. 

o Page Up and Page Down keys move the stage in 10 µm increments along the Z-

axis and will continuously move if held down. 

Notification and Progress Windows: 

• Information Window: Displays the current operational status of the app. 

• Progress Window: Shows the progress of the patterning process. 

• Time/Estimated Window: Displays the elapsed time for the scan and the estimated total 

duration. 

Blink Function: 

• Press the Blink button to toggle the laser on and off for the specified duration. 

• This feature is useful for testing laser intensity or drawing single points. 

Draw Line Tool: 

• Buttons labeled 1, 3, 6, 10 and an Erase button are provided for vector line drawing.  

o The numbers represent line widths in micrometers. 

• To draw:  

1. Select a line width button. 
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2. Left-click on the desired starting point in the microscope image. 

3. Move the mouse and click on the next point to draw a straight line. 

4. Continue clicking for a polyline. 

5. Right-click to finish the drawing. 

• To erase lines, click the Erase button and then click on the unwanted lines. 

Mask Pattern Loading: 

• Show Button: Displays a composite view of the captured microscope image, loaded mask 

pattern, and drawn lines. 

• All Button: Similar to the Show Button, but zooms out to display the entire writing area. 

• Zoom In/Out Buttons: Adjust the view incrementally. 

• Mask Button: Loads a mask image from the PC and displays it on the screen. To replace 

the mask, use the Image menu under the File menu. To erase the mask, use the Erase 

Mask option in the Raster Scan menu. 

Camera Configuration: 

• Gain and Expo.: Adjust the camera's gain and exposure time.  

o While observing the sample, these settings are set to Auto and may change 

dynamically. 

o For laser focusing, set these values to their minimum defaults for clearer focus 

visualization. 

• Camera Control "Auto" Button: Automatically adjusts the gain and exposure time, typically 

used for monitoring the sample surface. 

Movement Buttons: 

• The bottom of the right menu contains buttons for moving in the +X, -X, +Y, -Y, +Z, and -

Z directions. 

• Each click moves the stage by 10 µm. Holding a button continuously moves in the 

corresponding direction. 

Start Writing: 
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• Press the Start Writing button to begin patterning. 

• To stop the process, press the button again or left-click anywhere in the main window. 

• A confirmation message will appear, allowing the user to decide whether to stop or continue. 

• Upon completion or interruption, the screen image is automatically saved. 

 

 

Figure 3: Composite View Displayed After Pressing the Show All Button 

When the Show All button is pressed, the screen displays a composite view that overlays the 

mask pattern, captured microscope image, and drawn lines, allowing users to view all elements 

on a single screen for alignment and review. 
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Menu Description: 

File Menu: 

• Import Image: Load a saved pattern image from the PC. 

• Import Alignment Mark: Load alignment marks from saved files. 

• Import Line Pattern: Retrieve previously saved line patterns if line drawing was performed 

earlier. 

• Save Image: Manually save the current pattern to a file.  

o Note: Even if this option is not selected, the pattern image is automatically saved 

after drawing. 

Automatic Data Saving: 

• After completing a pattern, a folder named with the current date and time is automatically 

created within the desktop's Data folder. 

• All measurement data is saved automatically in this folder upon completion. 

  

 

 

(Settings): The Configuration Menu allows users to modify the overall settings for writing conditions 

and connected devices. 

  

Figure 4: File Menu Functions 

The File Menu allows users to: Use "Import Image" and "Import Alignment Mark" to load 

saved patterns from the PC. Select "Save Image" to save the current pattern for future 

use. 
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Figure 5: Configuration Menu 

The Configuration Menu provides options to adjust patterning conditions and settings for 

connected devices. 

 

Writing Configuration Dialog Box Description 

Line Drawing Mode: 

• A checkbox enables the mode for patterning by drawing lines with the mouse. Select this 

option if vector-based line drawing is required. 

Writing Area: 

• A dropdown menu allows selection of the side length of the square writing area. 

• For typical chip-scale devices, including contact pads, a size of 4–5 mm is recommended. 

Larger writing areas enable larger device fabrication but increase writing time. 

• The step size corresponds to 1/1000 of the writing area, determining the resolution for 

raster-scan patterns.  

o The magnification factor is automatically adjusted based on the step size. 

o Vector-based line drawing is not limited by this resolution. 

Laser Intensity: 

• Configurable for three cases: 

1. Inside: For filling the central area with a medium laser intensity (default value). 

2. Outside: For filling the outer area quickly with higher laser intensity and larger 

spacing between lines. 

3. Line: For drawing fine lines with low laser intensity (default value). 

• These default values are displayed in the respective input fields (inside, outside, and line) 

and can be adjusted by the user. 
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Writing Speed: 

• Controls the speed at which the laser focus moves:  

1. Inside: Speed for filling the central area is displayed in the inside field. 

2. Outside: Speed for filling the outer area is displayed in the outside field. 

3. Line: Speed varies depending on line width.  

▪ Fine lines are drawn faster, while thicker lines are drawn slower. Speeds for 

line widths of 1, 3, 6, and 10 µm are preset as default values. 

o Adjustments may be needed based on photoresist thickness and properties. 

Current Position: 

• Displays the current X and Y scanner positions. 

• Users can input values and click Go to move to the specified position. 

Laser Position: 

• Indicates the position of the laser focus. 

• Pre-calibrated values are set at release, but adjustments are recommended every month. 

• To adjust:  

1. Focus on the sample and turn on the laser. 

2. If the laser is too bright to locate the center on the screen, reduce the camera gain 

value. 

3. Identify the center of the focus and right-click to save the position. 

Step Motion: 

• +X, +Y, -X, -Y buttons move the scanner by the amount entered in the central input field 

in the respective direction. 

Saving and Exiting: 

• Press the Set button to save the configured values. 

• Click Done to exit the dialog. 

 



12 

 

 

Figure 6: Configuration Dialog Box 

The Configuration Dialog Box provides options for setting patterning conditions, such as 

writing area size, laser intensity, writing speed, and scanner positions. It also allows calibration 

of the laser position and step motion settings. 

 

Device Configuration 

Arduino Port Number: 

• When the Arduino processor is properly connected, the "connected" checkbox 

will be marked. 

• If the connection fails, you need to identify the correct COM port number for the 
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Arduino processor:  

o Open Device Manager in Windows. 

o Check the port number listed under the Ports (COM & LPT) section for 

the Arduino device. 

• Enter the correct port number in the input field and click the Initialize button.  

o A successful connection will mark the "connected" checkbox. 

Motor Scanner Drive: 

• The device uses a motor for driving the scanner. 

• If the motor temporarily stops functioning:  

1. Disconnect and reconnect the USB cable. 

2. Press the Initialize button to restore the connection. 

• The Standa motor's X, Y, and Z axes are used for axis adjustments. 

• On a new PC installation, axis configurations may differ:  

o If the app’s configured axes and the motor’s actual axes don’t align, adjust 

the settings to match. 

o Once set, the configuration is saved on the PC, so no further adjustments 

are needed. 

Camera: 

• If the Basler camera encounters a temporary error:  

o Click the Camera Initialize button to reset and restart the camera. 
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Figure 7: Device Configuration Dialog Box 

The Device Configuration Dialog Box provides options to: Set and initialize the Arduino port 

number for proper connection. Initialize the Standa motor for scanner control and adjust axis 

configurations if needed. Reset the Basler camera in case of temporary errors. 

 

Raster Writing 

Overview: 

Raster Writing involves filling areas to perform the writing process. The Raster Writing Menu 

includes the following functionalities: 

Features: 

1. Mask Pattern Loading: 

o Load a mask pattern to define the target area for writing. 

2. Target Pattern Verification: 

o Review and verify the loaded pattern for accuracy. 

3. Find Edges: 

o Automatically detects the edges of patterns and groups them using the Grouping 

process. 
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4. Simulate Writing: 

o Predicts the result of the writing process for review. 

5. Final Pattern Preview: 

o Displays a preview of the final pattern. 

Automation: 

• All the above processes are carried out automatically during writing, so manual intervention 

is generally unnecessary. 

Erase Mask Pattern: 

• If the current loaded mask image is unsatisfactory, use Erase Mask Pattern to remove it 

and start fresh. 

 

Figure 8: Raster Writing Menu 

In the Raster Writing Menu, the Erase Mask Pattern option allows users to delete a previously 

loaded mask image, enabling a fresh start for patterning. 
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Figure 9: Raster Writing Configuration Dialog Box 

The Raster Writing Configuration Dialog Box provides functionality to adjust the resolution 

separately for the center and outer areas of a pattern, allowing precise customization of the writing 

process. 

 

Raster Writing Configuration 

Overview: 

When the Raster Writing Configuration dialog box is opened, users can adjust the resolution for 

the center and outer areas of the pattern. This feature is designed to improve patterning speed by 

using maximum resolution for the center and lower resolution for the outer areas for faster 

processing. 

Features: 

1. Outside Low Resolution for Fast Writing: 

o Checkbox: Enable or disable this feature. 

o When checked, the outer portion of the pattern is drawn with lower resolution to 

improve speed. 

2. Outside Portion: 

o Specify the percentage of the pattern area to be treated as the outer portion. 
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3. Outside Subfactor: 

o Adjust the resolution of the outer portion manually. 

4. Outside Defocus: 

o Set how far the focus should shift from the optimal point for the outer area. This 

creates a broader spot for drawing, further enhancing speed. 

 

Vector Writing 

1. Start Vector Writing: 

o Begins the vector-based writing process, which involves drawing lines rather than 

filling areas. 

2. Stop Vector Writing: 

o Stops the current vector writing process. 

3. Delete All Lines: 

o Removes all drawn lines from the screen for a fresh start. 

 

 

Figure 10: Vector Writing Menu 

The Vector Writing Menu allows users to: Start the vector-based writing process with the Start 

button. Stop the writing process with the Stop button. Remove all drawn lines using the Delete All 

Lines button for resetting or reconfiguration. 

 

Mouse and Keyboard Operations 

Mouse Operations: 

1. Set Scan Area: 
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o Drag the mouse over a specific region of the camera image to draw a rectangle. 

This sets the defined area as the scan region. 

2. Point Selection: 

o Left-click on a point to bring up a dialog box:  

▪ Yes: Moves the selected point to the center of the screen. 

▪ No: Moves the selected point to the laser focus position. 

 

Keyboard Operations: 

1. X-Axis Movement: 

o Use the left and right arrow keys to move the sample along the X-axis. 

o Each press moves the sample by 100 µm. 

2. Y-Axis Movement: 

o Use the up and down arrow keys to move the sample along the Y-axis. 

o Each press moves the sample by 100 µm. 

 

Laser Focus Adjustment: 

1. The laser focus position is pre-calibrated during production but may require monthly 

adjustments. 

2. To adjust: 

o Focus on the sample and turn on the laser. 

o If the laser is too bright to locate the focus, reduce the camera gain to darken the 

screen for better visibility. 

o Right-click on the center of the focus with the mouse, triggering a dialog box:  

▪ Yes: Saves the new laser focus position. 

3. Once saved, the laser focus position persists even after restarting the PC. Adjustments can 

be made at any time. 
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Mask Align Menu: 

When a mask is loaded, three icons appear on the right side of the screen (as shown in Figure 11) 

for adjusting the mask's alignment. 

Icons and Their Functions: 

1. Move Icon ( ): 

o Allows moving the mask position. 

o Click the icon to activate it (turns red). Then, click and drag the mask to the desired 

location. 

2. Rotate Icon ( ): 

o Allows rotating the mask along the X and Y axes. 

o Click the icon to activate it (turns red). Then, click and drag in any direction to rotate 

the mask in parallel with your movement. 

3. Resize Icon ( ): 

o Allows resizing the mask. 

o Click the icon to activate it (turns red). Then, click and drag to stretch or shrink the 

mask along your movement direction. 

 

Fine-Tuning and Zoom: 

1. After capturing a camera image, these tools can be used to precisely align the mask with 

the captured image. 

2. Use the mouse wheel to zoom in and out of the entire image, enabling fine adjustment of 

the alignment. 
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Figure 11: UVW.exe App Main Window 

The main window of the UVW.exe app features: A low-magnification microscope image (5x) 

displayed in the center of the screen. The right-side menu, which includes controls for alignment, 

mask manipulation, and other operational settings. 

 

 

 

Maintenance Tools Menu: 

Stage Tilt Correction: 

This feature compensates for focus distortion caused by tilt in the sample stage or the sample itself, 

particularly during large-area writing. 

Procedure: 

1. Set Point 1: 

o Focus the microscope on a specific point on the stage. 
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o Click the Point 1 button to save the (x, y, z) coordinates of this point. 

2. Set Point 2: 

o Move the stage at least 5 mm along the X-axis. 

o Refocus and click the Point 2 button to save the second point's coordinates. 

3. Set Point 3: 

o Move the stage at least 5 mm along the Y-axis. 

o Refocus and click the Point 3 button to save the third point's coordinates. 

4. Calculate Tilt: 

o Click the Set button to calculate and save the stage's tilt in the X tilt and Y tilt directions. 

5. Enable Tilt Correction: 

o Check the Tilt Correction While Writing option to apply tilt compensation during the writing 

process. 

 

Usage Notes: 

• This feature is not necessary for small-area writing but is recommended for precise writing over 

areas larger than 5 mm. 
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Figure 12: Stage Tilt Correction Dialog Box Under Maintenance Tools 

The Stage Tilt Correction dialog box enables users to: Save coordinates for three points (Point 1, 

Point 2, Point 3) to calculate stage tilt. Apply tilt correction during writing by checking the Tilt 

Correction While Writing option. Display calculated tilt values for X tilt and Y tilt, ensuring precise 

alignment for large-area writing. 

 

Stripe Pattern Test 

The Stripe Pattern Test is designed to fine-tune the focus by identifying the z-value at which the 

line width becomes the narrowest. This is critical for ensuring that the visual focus on the screen 

aligns with the laser's focus on the photoresist (PR). 

 

Purpose: 

• To determine the optimal z-value for the thinnest line width. 

• Use this value to correct the laser focus from sample focus in the Objective Lens menu or 

adjust the Defocus value in the Configuration dialog. 

 

Procedure: 

1. Setting Parameters: 
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In the Stripe Pattern Test dialog box, adjust the following parameters: 

o Number of Lines: Total number of lines to be drawn. 

o Pitch: Distance between adjacent lines. 

o Speed: Laser movement speed. 

o Laser Intensity: Power of the laser. 

o Length: Length of each line. 

o z₀ (µm): Starting z-position. 

o z-step: Increment in z-value between each line. 

2. Execution: 

o Click Start to begin the test. 

o Lines will be drawn from z₀ - 5.0 µm to z₀ + 4.5 µm in steps as specified by z-step. 

3. Analysis: 

o After developing the sample, observe the striped pattern. 

o Identify the line with the narrowest width and note the corresponding z-value. 

4. Focus Correction: 

o Input the determined z-value into the laser focus from sample focus field in the Objective Lens 

menu under Maintenance Tools. 

o Alternatively, adjust the Defocus value in the Configuration dialog. 

o The writing process will apply a z-correction equal to the sum of laser focus from sample focus 

and Defocus. 
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Figure 13: Stripe Pattern Test Dialog Box 

The dialog box contains the following fields and buttons: 

• Left side:  

o Number of Lines 

o Pitch 

o Speed 

o Laser Int. 

o Length 

• Right side:  

o z₀ (µm): Starting z-position. 

o z-step: z-spacing between lines. 

• Start button initiates the pattern drawing. 
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